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Abstract – There are many electrically operated powers hack saw machine of different 

configuration and different manufactures are available for the use in machine shop. These machines 

can cut rods of different material precisely at very fast rate but they can cut rods of one material at a 

time which means they can’t able to cut dissimilar material at a same time. Now in industry, it is 

necessary to cut metal bars with very high rate to achieve mass production requirement. So, there is 

need to move for a new technology which gives us a mass production with less time and less energy 

input. It is impossible to depend upon conventional hack saw machine. By using this two-way hack 

saw machine, the two metal bar, pipes or rods can be cut the simultaneously to achieve high-speed 

cutting rate and mass production for maximum benefits in manufacturing industries.  

 This machine overcomes the drawbacks and limitation of single frame hack saw machine. It can 

be used in a small workshops and industries as it is available in very low price and its smaller size 

and high efficiency.  

 This paper focus on presents the manufacture and idea of two-way hacksaw removing machine 

predominantly conveyed for creation-based ventures. Businesses are fundamentally implied for 

creation of valuable merchandise and ventures at low generation cost, Machinery cost and low stock 

cost. Today in this world each errand has been made snappier and quick because of innovation 

progression yet this headway likewise requests colossal speculation and consumption, each industry 

wants to make high efficiency rate keeping up the quality and standard of the item at low normal 

cost. We have developed a prototype model, which is efficient and do multiple cutting operations. 

These machines can be utilized as a part of remote spots where power is customary. It is composed as 

a convenient one which can be utilized for cutting in different spots. It can be utilized for working on 

materials like thin metals, wood. 

 

Keywords:Double Hack saw, Slider Crank Mechanism, Arduino UNO. 

 

1 INTRODUCTION 
A hacksaw is a handheld device used to slice through materials like plastic tubing and metal funnels. 

Its cutting system is given by removable edges which include sharp teeth along their external edge. As 

a rule, a hacksaw comprises of a metal casing that takes after a descending confronting. A handle of 

plastic, wood, or metal is regularly joined to one end of the casing. The edge's closures highlight 
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customizable pegs that can be fixed to anchor a sharp edge set up, and extricated to expel it. Hacksaw 

sharp edges are long, thin portions of solidified steel that element a line of teeth along their front line. 

Each finish of the edge is punched with a little gap that fits onto the saw edge's pegs. Most sharp edges 

extend long from ten to 12inches (25.4 to 30.48 cm), albeit six-inch (15.24 cm) edges can be acquired 

to fit littler hacksaw models. A gadget that applies compel, alters the course of a power, or changes the 

quality of a power, with a specific end goal to play out an errand, by and large including work done on 

a heap. Machines are regularly intended to yield a high mechanical preferred standpoint to decrease 

the exertion expected to do that work. A straight forward machine a wheel, a lever or a slanted plane. 

Every single other machine can be constructed utilizing mixes of these straightforward machines. 

Illustration: A penetrates utilizes a blend of riggings (wheels) to drive helical slanted planes (the bore) 

to part a material and cut an opening in it. 

1.1Types of Sawing 
1.1.1Power Hacksawing – 

The basic forward and backward movement of the cutting edge made the hacksaw one of the 

principal kinds of sawing machines intended for control. The straightforwardness in the sharp edge 

movement has kept the cost of the saw machine generally less expensive than different kinds of 

sawing machines. The low introductory cost combined with the adaptability and versatility, has 

empowered the hacksaw to stay well known in industry. In hacksawing, a solitary sharp edge is 

tensioned in the bow, and responded forward and backward finished the work piece. The cutting 

activity is accomplished just amid half of the cycle of task. Amid the second 50% of the cycle, the 

arrival stroke, the sharp edge is lifted clear of the work piece, giving a spasmodic cutting activity, 

which is thought to be one of the disadvantages of the task. In spite of this inconvenience, when 

contrasted with the consistent cutting activity of the band saw, hacksaws remain similarly or much 

more famous elective machines. Likewise with numerous other fundamental procedures, hacksawing 

is an attempted and tried strategy, solid, reliably precise, fast and simple to repair, is less subject to 

remedy cutting edge strain and more averse to run-out. Besides control hacksaws can be left 

unattended for significant lots when cutting substantial distance across bar and require least 

administrator aptitude. Edge substitution is moderately shabby and straightforward. 

1.1.2   BAND SAWING– 

Band sawing, unlike hacksawing, is a continuous cutting operation. An endless blade, the 

band, is tensioned between two shrouded, rotating wheels, and part of the band is exposed to carry out 

the cutting operation of the work piece. The band travels in a continuous motion, with the teeth fed 

against the work piece. Whilst earlier metal sawing bands were wide (over 25 mm), and were used 

strictly for cut off methods, narrow blades, introduced about 50 years ago brought contouring 

capabilities. Furthermore, due to the small throat clearance of the early band saws, they were limited in 

use by the basic design, thus the length of the work piece could only be as long as the machine throat. 

However modern machines have been modified to give adequate throat clearance, by intentionally 

twisting the blade so that the toothed faces in line with the machine throat. As with hacksaw machines, 

band saws can be divided into two broad categories. A general-purpose band saw having gravity fed 

system, controlled by a dash-pot and using a25 mm (1 inch) deep blade, is the most popular machine 

available. This machine is suitable for general fabrication work and accurate cutting of solid bars. This 

type of machine is limited to about 175 mm (7 inches) diameter for mild steel. In order to meet the 

present-day requirements for high-volume production, cutting all grades of steel and to introduce high 

accuracy and reliability, it has been necessary for the band saw machine manufacturers to incorporate 

in the design not only heavy-duty construction having capacities up to 450 mm (18 inches) diameters 

but also innovations in the hydraulic power down feed, to allow the cutting of difficult alloys., such as 

mnemonics and titanium. 

1.1.3 CIRCULAR SAWING – 

Roundabout saws have a constant cutting activity; utilize sharp edges having numerous teeth, 

and an extensive scope of rotational velocities. This activity is like a processing task. The machines 

accessible range from the prior, economical, hand-stacked models to the specific vast, control stacked 

write and join material taking care of gadgets for semi and after that completely programmed task. 

Present day generation roundabout saws are worked with a few substitutes essential feed components 

i.e. level, vertical, shaking head and varieties of these. The decision of the most appropriate kind of 

machine relies upon the specific application and the size and state of segment. With vertical feed, the 
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pivoting edge ventures downwards in a straight line to draw in the work piece. On machines intended 

for even feed the cutting edge is sustained into the work piece from the back. A third fundamental 

encouraging plan is a turn movement or shaking head framework, this is as proficient as a vertical feed 

framework and is a tough course of action. The seat or floor mounted manual- feed round observed, 

when introduced together with a general obligation band saw or hacksawing a little workshop, gives 

an entire slicing office to the little fabricator. Completely programmed round saws, having highlights, 

for example, dial-in segment length, in process checking, decision of stacking magazines, and so on 

are broadly utilized where top-notch creation is required and frequently give the generation build a 

troublesome decision to make between roundabout sawing and band sawing. 

 

1.2 Manufacturing Process 

1.2.1 Mild Steel: 
Mild steel is a kind of carbon steel with a low measure of carbon – it is entirely known as 

"low carbon steel." Although ranges differ contingent upon the source, the measure of carbon 

ordinarily found in mellow steel is 0.05% to 0.25% by weight, while higher carbon steels are normally 

depicted as having a carbon content from 0.30% to 2.0%. In the event that any more carbon than that 

is included, the steel would be delegated solid metal. Mellow steel isn't composite steel and, in this 

manner, does not contain a lot of different components other than press; you won't discover huge 

measures of chromium, molybdenum, or other alloying components in mild steel. Since its carbon and 

alloying component content are generally low, there are a few properties it has that separate it from 

higher carbon and composite steels. Less carbon implies that mild steel is regularly more bendable, 

machinable, and weldable than high carbon and different steels, in any case, it likewise implies it is 

almost difficult to solidify and fortify through warming and extinguishing. The low carbon content 

likewise implies it has next to no carbon and other alloying components to square disengagements in 

its gem structure, by and large bringing about less elasticity than high carbon and compound steels. 

mild steel additionally has a high sum iron and ferrite, making it attractive. 

 

1.2.2 Manufacturing: 
Mild steel is made like how other carbon steels are made. A typical way this is done includes 

a blend of iron metal and coal. Once the coal and iron mineral are separated from the earth, they are 

softened together in an impact heater. Once dissolved, the blend is moved to another heater to 

consume off any polluting influences that they may have, and also to make some other changes in 

accordance with the mild steel's synthetic organization. Following that, the steel is permitted to cement 

into a rectangular shape. This piece of mellow steel is then more often than not conveyed down to the 

coveted size utilizing forms called hot rolling or cool illustration, despite the fact that there are 

different techniques that can likewise be utilized. 

2. LITERATURE REVIEW  

David Gordon Wilson studied the vast literature to understand the concepts which effect the 

performance of the machine The concept of two-way hacksaw cutting machine mainly carried out for 

production-based industries. 

Zoeb khan expressed that Industries are essentially implied for generation of valuable merchandise 

and enterprises at low creation cost, Machinery cost and low stock cost. Information about built up a 

model of a machine reach would be fit for performing diverse task all the while, and it ought to be 

monetarily productive. These machines can be utilized as a part of remote spots where power is 

customary. It is planned as a versatile one which can be utilized for cutting in different spots. It can be 

utilized for working on materials like thin metals, wood. A solitary stage vertical electric engine 

unbendingly set at the focal point of metallic establishment gave. 

Linxu et al. research about the shaft of motor rotates at 90- 100 rpm with the power 2HP. The circular 

disc is mounted on the shaft of motor with the help of key and key slot arrangement. It consists of 

pedal powered machine setup which has a simple mechanism operate with chain and sprocket 

arrangement. 
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Chaudhary Pravin kumar k learned about the chain is put on the teeth of the haggle. The pole is 

mounted on platform direction. To begin with mechanical linkage is evacuated by expelling nut and 

screws and v belt drive boring connection. It is realized that regular power hacksaw machine can be 

supplanted with robotized control Hacksaw machine.  

S. G. Bahaley et al. expressed that automated power hacksaw machine gives high efficiency in brief 

day and age in examination with the ordinary power hacksaw machines. The real preferred standpoint 

of this machine is intercession of work is lessened to greatest level. In this fast-developing modern 

segment the utilization of intensity Hacksaw machine is wide, time and work assume a noteworthy 

part underway process. The Material choice and testing of hacksaw sharp edge in light of mechanical 

properties expressed that the suitable saw edge must be chosen for better activity and fine cutting by 

choosing number of teeth per inch. 

Leonel et al. stated that the designers of machines or structures must achieve acceptable levels of 

performance and at the same time, assure the part is safe and durable. Therefore, it is necessary to 

avoid excess deformation, such as bending, twisting, or stretching, of the machine’s components. In 

addition, cracking in components must be avoided entirely to prevent the crack from progressing to the 

point of complete fracture to avoid structural failure, the stress in a component must not exceed the 

strength of the material, where the strength is simply the stress that causes a deformation or fracture 

failure. Failures in mechanical structures occur due to various reasons.  

Boyer et al. showed that failures could occur due to mechanisms and environmental factors. He also 

suggested that failure analysis of a metal structure requires identifying the type of failure mode. The 

failure mode is classified as either a deformation or fracture. 

Layer et al. concluded that the process of identifying a failure mode is complicated because different 

techniques can be used to determine the actual cause of failure. 

 Linder et al. studied and they are worried about the numerical displaying of split expanding in weak 

materials utilizing limited components with installed solid discontinuities, that is, discontinuities in the 

relocation field characterizing the arrangement of the basic limit esteem issue. Specifically, new 

limited components are produced in this structure pleasing the distinctive branches of the bifurcating 

intermittence in the component inside. The key part of these advancements is the right portrayal of the 

kinematics of these designs. This is expert through the distinguishing proof of the correct partition 

modes portraying these arrangements and their fuse in the discrete strain field of the limited 

component. The subsequent improved modes are enacted in view of a spreading model contingent 

upon the speed of the break tip. The execution of the new components is represented with a few 

numerical reproductions including different methodologies for the treatment of expanding and 

examinations. 

Travas et al. investigated the influence of loading rate on the failure mode of the beam parametric. 

The numerical results are evaluated, discussed and compared with test results known from the 

literature. It is shown that the beam resistance and failure mode strongly depend on loading rate. For 

lower loading rates beam fails in bending (mode-I fracture). However, with increasing loading rate 

there is a transition of the failure mechanism from bending to shear. Results are in good agreement 

with theoretical and experimental results known from the literature.                                     
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3. METHODOLOGY 

In this paper mainly focused the power supply is provided to the motor and the power is 

transmitted to rotorplate by attaching to shaft of the motor. Two connecting rods are attached to the 

rotor plate, then these two connecting rods are attached to the hack saw frames then the entire system 

works as slider-crank mechanism, coverts the rotatory motion coverts into reciprocating motion. 

Fig 3.1 Block Diagram 

     3.1 Hardware Requirements: 

• DC Motor 

• Nuts 

• Bolts 

• Iron Frame 

• Arduino Uno 

• Bluetooth 

• Battery 

• Middle Arm 

• Rotating Shaft  

3.2 ComponentDescription 

3.2.1 MiddleArm-Itisusedtobalancethemotoranditisattachedtoshaft.Its dimension is 

(23x9x6.5) inch. 

Fig 3.2 MiddleArm 

3.2.2. Bolt- It is used for the fixing of bench vice for proper alignment of shaft and flywheel. 
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Fig 3.3Bolt 

 

3.2.3. Nut- It is used in bench vice, connecting rod and shaft for tightening bolts. 

 

 

 

                           Fig3.4 Nut 

3.2.4.Base-Itisstandonwhichallpartsaremountedlikedcmotor, shaft size (66 x 45.5 x 25) cm 

 

Fig 3.5-Base 

3.2.5.RotatingShaft-Itisusedhereformovingofbotharmscarrying hacksaws. 
 

             Fig3.6–Rotating Shaft 

3.2.6 Shaft 

A shaft is a pivoting machine component which is utilized to transmit control starting with one place then onto 

the next. The power is conveyed to the shaft by some unrelated power and the resultant torque (or turning minute) set up 

inside the shaft allows the ability to be exchanged to different machines connected up to the shaft. Keeping in mind the 

end goal to exchange the power starting with one shaft then onto the next, the different individuals, for example, pulleys, 

gears and so forth., are mounted on it. These individuals alongside the powers applied upon them makes the shaft bowing. 

As it were, we may state that a shaft is utilized for the transmission of torque and bowing minute. The different individuals 

are mounted on the shaft by methods for keys or splines. 

3.2.7. Hacksaw 

A hacksaw is a fine-tooth saw with an edge under pressure in a casing, utilized for cutting materials, for example, 

metal. Hand-held hacksaws comprise of a metal edge with a handle, and sticks for joining a thin dispensable cutting edge. 

A screw or other system is utilized to put the thin cutting edge under pressure. A power hacksaw (or electric hacksaw) is a 

sort of hacksaw that is controlled by electric engine. Most power hacksaws are stationary machines yet some helpful 
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models do exist. Stationary models commonly have a framework to lift up the saw sharp edge on the entry stroke and 

some have a coolant pump to keep the saw bleeding edge from overheating. 

 

 

Fig 3.7– Cutter Blade 

 

 

3.2.8. DC Motor 

A DC motor is an electric motor driven by an immediate current (DC). The DC motor usually comprises of two 

essential parts, an outside stationary stator having loops provided with substituting current to deliver a pivoting attractive 

field, and an inside rotor connected to the yield shaft creating a second turning attractive field. The rotor attractive field 

might be created by lasting magnets, hesitance saliency, or DC or AC electrical windings. The responding movement of 

the Hacksaw sharp edge, as a result of which the cutting procedure happens, is delivered with the assistance of a DC 

motor, which works by a basic wrench component to change over rotating movement of wrench into responding 

movement Hacksaw edge. The DC motor is turned on after the work- piece has been immovably fit in the pneumatic 

toss. The Torque of motor is expanded by transmission of capacity to a pulley by belt transmission. 

Fig 3.8 DC Motor speed- 50 rpm 

4 HARDWAREDESCRIPTION 

4.1 ArduinoUNOBoard 

Arduino is a single-board microcontroller meant to make the application more accessible, 

whichareinteractiveobjectsanditssurroundings.Thehardwarefeatureswithan open-source 

hardwareboarddesignedaroundan8-bitAtmelAVRmicrocontrollerora32-bitAtmelARM. 

CurrentmodelsconsistsaUSBinterface,6analoginputpinsand14digitalI/Opinsthatallows the user to attach various 

extension boards. 

The Arduino Uno board is amicrocontroller basedon the ATmega328. It has 14 digital input/output pins in 

which 6 can be used as PWM outputs, a 16 MHz ceramic resonator, an 

ICSPheader,aUSBconnection,6analoginputs,apowerjackandaresetbutton.Thiscontains all the required support 

needed for microcontrollers. In order to get started, they are simply connected to a computer with a USB cable or 

https://www.elprocus.com/types-of-avr-microcontroller-atmega32-and-atmega8/
https://www.watelectronics.com/8051-microcontroller-architecture/
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with anAC-to-DC adapter or battery.Arduino Uno Board varies from all other boards, and they will not use the 

FTDI USB-to-serial driver chip in them. It is featured byAtmega16U2 (Atmega8U2 up to version R2) 

programmed as a USB-to-serial converter. 

 

Fig 4.1 Arduino UNO board 

4.2 Relay 

 

 

Fig 4.2 Relay 

The relay is the device that open or closes the contacts to cause the operation of the other electric 

control. 

It detects the undesirable condition with an assigned area and gives the commands to the circuit 

breaker 

to disconnect the affected area through ON or OFF. 

    Every electromechanical relay consists of 

Electromagnet 

Mechanically movable contact 

Switching points and 

Spring 

4.3 Bluetooth Module Hc-05 

• It is used for many applications like wireless headset, game controllers, wireless 

mouse, wireless keyboard and many more consumer applications. 

• It has range up to <100m which depends upon transmitter and receiver, atmosphere, 

geographic & urban conditions. 

• It is IEEE 802.15.1 standardized protocol, through which one can build wireless 

Personal Area Network (PAN). It uses frequency-hopping spread spectrum (FHSS) 

radio technology to send data over air. 

• It uses serial communication to communicate with devices. It communicates with 

microcontroller using serial port (USART). 

• HC-05 is a Bluetooth module which is designed for wireless communication. This 

module can be used in a master or slave configuration. 

https://en.wikipedia.org/wiki/Personal_area_network
https://en.wikipedia.org/wiki/Frequency-hopping_spread_spectrum
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Fig 4.3 Bluetooth Module 

5 SOFTWARE DESCRIPTION 
5.1 Arduino Software (Ide) 

The Arduino Integrated Development Environment - or Arduino Software (IDE) - contains a 

text editor for writing code, a message area, a text console, a toolbar with buttons for common 

functions and a series of menus. It connects to the Arduino and Genuine hardware to upload programs 

and communicate with them. 

5.2 Writing Sketches 

Programs written using Arduino Software (IDE) are called sketches. These sketches are 

written in the text editor and are saved with the file extension. The editor has features for 

cutting/pasting and for searching/replacing text. The message area gives feedback while saving and 

exporting and also displays errors. The console displays text output by the Arduino Software (IDE), 

including complete error messages and other information. The bottom corner of the window displays 

the configured board and serial port. The toolbar buttons allow you to verify and upload programs, 

create, open, and save sketches, and open the serial monitor. 

NB: Versions of the Arduino Software (IDE) prior to 1.0 saved sketches with the extension. It 

is possible to open these files with version 1.0, you will be prompted to save the sketch with the 

extension on save. 

5.3Steps: 

 

1. Download and install Arduino IDE (https://www.arduino.cc/en/Main/Software) 

2. Plug in your Arduino Board 

3. Select the proper board in the IDE (Tools>Boards>Arduino Uno) 

4. Select the proper COM port (Tools>Port>COMx (Arduino Uno)) 

5. Open the “Blink” sketch (File>Examples>Basics>01.Blink) 

6. Press the Upload button to upload the program to the board 

7. Confirm that your board is working as expected by observing LED Troubleshooting  

Uploading Errors: 

Arduino has lots of community support and documentation. Your best bet when running into 

unexpected problems is to search online for help. You should be able to find a forum where someone 

had the same problem you are having, and someone helped them fix it. If you don’t find results, try 

modifying your search, or post on the Arduino forums. 

● My board isn’t listed under devices and is not recognized by IDE: 

 

○ Most likely, this means that the ATMega328p chip is not programmed with the Arduino 

firmware. If you have a separate working Uno available, you can program the unprogrammed 

chip using this guide and a few jumper cables: https://www.arduino.cc/en/Tutorial/ArduinoISP 

○ If you don’t have a separate Arduino available, let me know and I can use an Atmel 

Programmer to upload the firmware. 

○ There may be hardware damage if you had the board plugged into USB and external power at 

the same time. You may have to replace the chip if this is the case. 

● Error Message: avrdude: stk500_recv (): programmer is not responding 

○ Double-check that you are using the correct COM port. 

○ Make sure that your Arduino Board is plugged into the computer.The IDE says “Uploading…” after pressing 

the upload button, but nothing is happening. 

○ Double-check that you have the correct board selected in the Tools menu. 

○ Depending on the size of your program, it may take a few seconds to upload. If you feel like it is taking too 

long, it may be encountering an error and you can try unplugging and plugging in the Arduino board. 

https://www.arduino.cc/en/Main/Software
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6. RESULTS AND DISCUSSION

 
Fig 6.1 Fabricated Model 

6.1 MACHINE CUTTING TIMINGS FOR DIFFERENT MATERIALS 

TABLE 6.2 CUTTING TIMINGS FOR DIFFERENT MATERIALS 

7. CONCLUSION 
Itisrealizedthatordinaryhacksawmachinecanbesupplantedwithprogrammedtwofold hacksaw machine. 

Programmedtwofoldhacksawmachinegiveshighefficiencyin brief era in examination with the regular hacksaw 

machines. The real favorable position of this machine is that intercession of work is diminished to greatest level. In 

this fast-developing moderntime,theutilizationoftwofoldHacksawmachineiswide.Timeandworkassumea noteworthy 

part underway process this can be overwhelmed by utilizing this sort of 

programmedmachines.Theprogrammedhacksawmachinecanbemadeutilizationofatany of the ventures like furniture 

enterprises. The scope of size of work-pieces that can be cut utilizing the programmed hacksaw machine can be 

shifted by changing the sharp edge estimate. Right now, the machine utilizes 12-inch edge for cutting. 

• It is realized that customary hacksaw machine can be supplanted with Automated Double Hacksaw machine. 

• ComputerizedDoubleHacksawmachinegiveshighprofitabilityinbriefdayandage in examination with the 

Motor speed 50rpm 

Depth of cut  3mm/cut 

Bladespecifications 12x1x0.5 cm 

S. NO MATERIAL SPECIFICATIONS TIME 

1 WOOD 1 INCH BAR 60 SEC 
2 PLASTIC 1 INCH BAR 20 SEC 
3 ALLUMINIUM 1 INCH BAR 40 SEC 
4 MILD STEEL 1 INCH BAR 100 SEC 
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regularhacksawmachinehacksawmachines.Therealpreferredstandpointofthismachine is mediation of work is 

diminished to greatest level. 

• Inthisfast-developingmechanicalsegmenttheutilizationoftwofoldHacksawmachineis wide, time and work assume a 

noteworthy part underway process. This can be overwhelmed by utilizing this kind of computerized machines. 

Therobotizedhacksawmachinecanbemadeutilizationofatanyoftheventureslikepump fabricatingbusinessesthat 

includemassmeasureofshaftsthatmustbecuteverynowand again.Thescopeofsizeofwork-

piecesthatcanbecututilizingthecomputerizedhacksaw machine can be fluctuated by changing the cutting-edge 

measure.As of now, the machine utilizes 12-inch sharp edge for cutting. Another headway that can be executed in 

mechanized hacksaw machines is that the client can likewise get cut work-bits of various lengths in a single cycle 

itself. This implies the client needs to indicate the quantity of 

workpiecesthatmustbecutineveryoneofthedistinctivelengthesteemsdetermined.This will be conceivable with the 

assistance of a progressed microcontroller than AT89C51,which ought to have high programmable memory. 
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